Welcome to Leopard




How to get started

www.apple.com/support




[ Apple Inc.

© 2007 Apple Inc. All rights reserved. Apple, the

Apple logo, Boot Camp, Exposé, FireWire, iCal, iPhoto,
Keynote, Mac, and Mac OS are trademarks of Apple Inc.,
registered in the U.S. and other countries. Aperture,
Cover Flow, Finder, iPhone, Leopard, Safari, and
Spotlight are trademarks of Apple Inc. AppleCare is a
service mark of Apple Inc,, registered in the U.S. and
other countries. .Mac is a service mark of Apple Inc.
Other product and company names mentioned herein
may be trademarks of their respective companies.

Microsoft product screen shot(s) reprinted with
permission from Microsoft Corporation.

Because Apple frequently releases new versions and
updates to its software, images shown in this book may
be different from what you see on your screen.



To upgrade to Mac OS X Leopard, insert your installation disc and double-click Install
Mac OS X.Then click Restart. Your computer restarts, and the Mac OS X Installer opens.

Q o ﬂ 2/ Mac OS X Install DVD o

2 3 items, 3.6 MB available

Install Mac OS X

Install Mac OS X

Click the button below to restart
your computer and begin the
installation process.



Select your startup disk or the volume that has the version of Mac OS X you want to
upgrade.

Select a Destination
Select a volume. You may not

Where do you want to install Mac OS X?

— = -I be able to install Leopard on
i 6 =] some volumes.
Backup Macintosh HD J
5.9 GB available 20 GB available
37.3 GB total 36.8 GB total

Look here for important

Installing this software requires 9 GB of space.

You have chosen to upgrade Mac OS X on this volume. information abOUt the
installation.
( Options ( GoBack ) Continue

Click Options if you want
to select a different type of
installation.

For additional information, see the Instructions folder on your installation disc.



When you're ready, click Install to begin installing Mac OS X Leopard. When the installation
is finished, your computer will restart.

Install Summary

Mac OS X will be installed on the “Macintosh HD" volume.

2 = ‘.'m -~
i

To begin installing Mac OS X, click Install.
To change your installation settings, click Customize.
Your computer will restart after the installation is complete.

((GoBack ) (_Install )

Click Customize if you want
to change what’s installed.






Meet Leopard

www.apple.com/macosx
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Stacks provide a convenient way to get to your documents. Folders already in the Dock
become stacks automatically. To create a stack, drag a folder of documents to the Dock.

Allen Fishing Italian Architecture School Newsletter

Surf Instructor Show in Finder

When you click a stack, the
items appear in a grid or a fan
above the icon.



The Downloads stack
The Dock includes a Documents stack and a Downloads stack. ltems you download in
Safari, Mail, or iChat always go to the Downloads stack so that you can find them quickly.

Show in Finder 0

aence Report 3 -5
|

|
.‘7 'ACE [

w

—_—

School Newsletter ]

L
PAGES

Plate Tectonics

The latest download
appears here.

Party Cover Letter

e
-

2 .

3

P

Click the Downloads stack to
see items you've downloaded.

10 Desktop



Stacks appear as a fan or a grid automatically based on the number of items in the stack.
You can specify which style you want to use and change the stack’s sort order.

Sort by >
Automatic
Remove from Dock v Fan

Show in Finder Grid

Open “Downloads”

To customize a stack, position the pointer
over the stack icon and then hold down
the mouse button until a menu appears.

11
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Finder

¥ DEVICES
= Macintosh HD
9 ipisk
E Backup -

¥ SHARED

B Mom's Mac

& gill's MacBook
® an...

¥ PLACES

B3 Deskeop

@} annejohnson
2\ Applications
B Documents

¥ SEARCH FOR
L) Today

L Yesterday

) Past Week

& Al Images

& Al Movies

Plate Tecto

School Newsletter
Pages Publication

Date Modified Size Kind

& All Documents

& Allen Fishing

& At the Lake

W Canoeing

® City Symphony Poster

= Family

8 [talian Architecture
Party Cover Letter
Plate Tectonics
School Newsletter
¥ Science Report
as Smile
' Surf Instructor

 lof1a selected, 43

7/16/07, 10:44 AM 111.8 MB TIFF image
7/16/07, 2:42 PM 111.8 MB TIFF image
7/16/07, 2:40 PM 111.8 MB TIFF image
6/28/07, 2:35 PM 884 K8 Portable Document Format (PDF)
7/27/07, 4:27 PM 47.6 M8 TIFF image
57.6 MB Keynote Document

6/28/07, 2:36 PM
9/2/07, 4:48 PM 136 K8 Pages Publication
6/28/07, 235 PM 6.8 MB Keynote Document
256 K8 Pages Publication
192 K8 Pages Publication

7/27/07, 4:27 M 47.6 M8 TIFF image
7/26/07, 458 M 47.6 MB nif.hwg v‘
.24 GB available . s m— )

4G s

Simite

At the Lake

_PAGES

Science Report

Alien Fishing

makan Architecture

Surfing Hawai

PAGES

Party Cover Letter



Cover Flow lets you see your movies, presentations, PDF files, and more in large-size

previews as you flip through them.

‘ﬂ(\ﬂ

(>}

¥ DEVICES
|Z) Macintosh HD

@ ipisk

¥ SHARED
B Mom's Mac
& ill's MacBook
@ All...

¥ PLACES
E Desktop
m annejohnson
v}\! Applications

ji D

¥ SEARCH FOR
(&) Today
(5 Yesterday
(L) Past Week
(& Al iImages
(& All Movies

E Backup a

AL

& Documents

23 ajin

58 All Documents  [SS Name Date Modified Size | Kind
#. Allen Fishing 7/16/07, 10:44 AM 111.8 MB TIFF image
W Atthe Lake 7/16/07, 2:42 PM 111.8 MB TIFF image
B canoeing 7/16/07, 2:40 PM 111.8 MB TIFF image |
L3 City Symphony Poster 6/28/07, 2:35 PM 884 KB Portable Document Format (PDF) |
m Family 7/27/07, 4:27 PM 47.6 MB TIFF image |
[ halian Architecture 6/28/07, 2:36 PM Keynote Document |
Party Cover Letter 9/2/07, 4:48 PM 136 KB Pages Publication
B Plate Tectonics 6/28/07, 2:35 PM 6.8 MB Keynote Document ‘
= School Newsletter 9/2/07, 4:48 PM 256 KB Pages Publication
¥ Science Report 9/2/07, 4:48 PM 192 KB Pages Publication
# Smile 7/27/07, 4:27 PM 47.6 MB TIFF image .
% Surf Instructor 7/26/07, 4:58 PM 47.6 MB TIFF image v
Slecdic g chasiahie] L

Click this button
for Cover Flow.

Move the pointer over
an item to play a movie
or see the pages of a
document, for example.

Drag the slider to
thumb through your
documents.

13



Sidebar

The Finder sidebar makes it easy to get to folders on your computer, shared computers on
your network, and your saved searches.

¥ DEVICES

[3 Macintosh HD
iDisk
@ Backup -

¥ SHARED Shared computers
B Mom’s Mac available on your network
& e .
Bill's MacBaok automatically appear here.

® All...

¥ PLACES
Desktop
fﬁ annejochnson

ﬁ Applications
B} Documents

¥ searcH FoR ——— Commonly used searches are
D Today included in the sidebar, and you
b XEsETOaY can add your own searches.
(L) Past Week
ﬁ All Images
|2 All Movies
| & All Documents

14 Finder



In a Finder window or the menu bar, use Spotlight to search for items on your computer. If
you use the same search often, save it in the Search For section of the sidebar.

Type your search in

SN L&) Searching “Documents” =
[ ‘, ’] [:: == m Q school trip  — the SearCh ﬁeld.

¥ DEVICES Search: This Mac @L<l 3 Shared Save ) (+

|Z} Macintosh HD
@ ipisk
= Backup -

[ Click Save to add a
Smart Folder to the
sidebar.

¥ SHARED
I Mom'’s Mac
I gill's MacBook
® An..

¥ PLACES
E Desktop
Q annejohnson
'/A: Applications
ii Documents

See your search results
in Cover Flow.

¥ SEARCH FOR

() Today
L) Yesterday Science Report
(L) past Week Pages Document
(@] All Images
& All Movies
& Al Documem | Date Modified Size | Kind
B Away from School Jul 16, 2007, 2:40 PM 111.8 MB TIFF image
& Fishing Trip Jul 16, 2007, 10:44 AM 111.8 MB TIFF image
Letter to Parents Sep 3, 2007, 4:13 PM 136 KB Pages Document
lJ Science Report Sep 5, 2007, 2:11 PM 192 KB Pages Document
&l Trip to the Lake Jul 16, 2007, 2:42 PM 111.8 MB TIFF image
T Welcome Back Aug 24, 2007, 6:01 PM 256 KB Pages Document

_(,) annejohnson Q) Documents % Science Report

1 of 6 selected - 2

15
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Shared computers on your network automatically appear in the sidebar so that you can
quickly find the documents they contain.

enn L& billiames |

—— Search for documents
on shared computers.

| ¥ pEviCES
[ Macintosh HD
@ ipisk
) Backup &
¥ SHARED
B Mom's Mac
I gill's MacBook
® Al

¥ PLACES
E Desktop
£ annejohnson
-}X! Applications
1l Documents

¥ SEARCH FOR

() Today
() Yesterday Clark Rafting Trip
(L) Past Week Portable Document Format (PDF)
(& All Images
& All Movies
‘ {&] Al Documents | - Date Modified Size Kind | . .
& Allen Fishing Jul 16, 2007, 10:44 AM 12ME  TIFF image — Get |mmed late access
W Ccanoeing Jul 16, 2007, 2:40 PM 8 MB TIFF image |
B Clark Rafting Trip Today, 10:54 AM 2.1 MB Portable Document Format (PDF) H
> |_(71 Drop Box Feb 19, 2007, 7:32 AM - Folder | to the Pu bl IC fOIder On
__ Family Budget Sep 2, 2007, 4:47 PM 8.5 MB Numbers document | h d
__| Remodeling Plans Sep 2, 2007, 4:46 PM 8.6 MB Numbers document : a ny S a re Com puter.
&l The Lake Jul 16, 2007, 2:42 PM 12 MB TIFF image
2 1 0f 7 selected, 48.46 GB available v




Use screen sharing to get to the desktop of shared computers on your network. You can

monitor

LN

¥ DEVICES

\=| Macintosh HD
@ ipisk
X Backup

¥ SHARED
I8 Mom’s Mac
8 ill's MacBook
@ All...

¥ PLACES
E Desktop
&} annejohnson
7 Applications
i Documents

¥ SEARCH FOR
«i‘ Today
Q‘ Yesterday
(1) Past Week
|2 All Images
& All Movies
& All Documents

use, change settings, and much more from your computer.

|| Marta’s Mac =)

Gal= o0 o J(&-] Select the c_omputer
Connected as: Guest and then click Share

Screen.

(3] (&— : To see the
toolbar, choose
e View > Show
Toolbar.
ey v
( ,:i&;m’mw‘
el T S You'll see the
Z, desktop of the

sssss

other computer

ickTime  Sharin

in a window.

To use all of your screen, click
the Full-screen button.

17
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You can share your files, your website, your screen, and much more with other computers

on your network. To start, open System Preferences and then click Sharing.

Sharing

(Hel(g) :
‘EE] Q ) |
|

Computer Name: Anne's iMac

Computers on your local network can access your computer at: Annes- Edit
iMac.local

On  Service © File Sharing: On
| #  Screen Sharing Other users can access your computer at afp://205.27.85.112/ or browse
‘ M File Sharing for "Anne's iMac”.

@ Printer Sharing
| ™ Web Sharing Shared Folders: Users:
| ™  Remote Login [ Anne Joh..lic Folder % AnneJohnson  Read & Write
| "1 Remote Management 28 Users Read Only

1 Remote Apple Events a8 Everyone Read Only
| [T]  Xgrid Sharing
| Internet Sharing
|
| .

| Click the Add (+) button to

\ +]-] [+]- select users and groups who

, can share your files.

14 Click the lock to prevent furtherfchanges. @

Click the Add (+) button to
select any folder you want
to share.



Back to My Mac
With your .Mac membership, an Internet connection, and Back to My Mac and sharing
services turned on, you can access any of your computers from anywhere on the Internet.

.Mac is the only online service that lessly ds your Mac experience
@ .mac to the Internet.
~! Account Sync iDisk | BacktoMyMac }

Back to My Mac: On

Using Back to My Mac you can access this computer, and services such as file sharing and
screen sharing, from your other computers that have Back to My Mac enabled.

m Click Stop to turn off Back to My Mac on this computer. You will no longer be able to access
L

this from other using Back to My Mac. Back tO My Mac iS
::es:s'::::r;gl:;:f;mnus 1o turn on sharing services, such as file sharing O n a UtO m atica | |y.

¥ DEVICES
Macintosh HD - -
iDisk
E Backup -

VSHARED Desktol Documents Downloads

Back to My Mac computers —— & ame:wer o ‘
. . U8 gill's MacBook
appear in the sidebar. @ -

¥ PLACES
! Desktop
&Y annejohnson Library Movies Music
ﬁ Applications
B Documents.

T m om -

Pictures Public Sites

Finder 19



20

Quick Look

Jon 28, 2007, 2:35 P
Jun 28, 2007, 2:35 PM
Jon 28, 2007, 2.3 MM
127, 2007, 4:27 oM
Jon 28, 2007, 2:35 P
bl 27. 2007, 4:27 '

Kind
Portable Document Format (POF)
Portable Document Format (PDF)
Portable Document Format (PDF)
TIFF image

Portable Document Format (POF)
TIF image

Portable Document Format (POF)




You can use Quick Look in the Finder, Time Machine, and Mail. To view an item in Quick

Look, select it and then press the Space bar.

(&) lala) LQJ Documents

€ )
a ]

”4 >

¥ DEVICES

|=} Macintosh HD
@ ipisk
=1 Backup A
¥ SHARED
I Mom's Mac
B84 gill's MacBook
® All...

¥ PLACES

E Desktop
£ annejohnson
'}x_ Applications
B Documents

¥ SEARCH FOR

&/ All Documents

EesERNE®BE

& Allen Fishing

W At the Lake

B canoeing

w4 City Symphony Poster

Date Modified

|
(5 Today
() Yesterday City Symphony Poster.pdf
(L) Past Week Portable Document Format (PDF)
(& All Images
& All Movies

|

|

7/16/07, 10:44 AM

7/16/07, 2:42 PM
7/16/07, 2:40 PM
6/28/07, 2:35 PM
7/27/07, 4:27 PM
6/28/07, 2:35 PM
6/28/07, 2:36 PM
6/28/07, 2:35 PM
7/27/07, 4:27 PM
7/26/07, 4:58 PM
7/26/07,3:01 PM
7/27/07, 4:27 PM

Size
111.8 MB
111.8 MB
111.8 MB
884 KB
47.6 MB
112 KB
57.6 MB
6.8 MB
47.6 MB
47.6 MB
111.8 MB
47.6 MB

Kind

TIFF image

TIFF image

TIFF image

Portable Document Format (PDF)
TIFF image

Portable Document Format (PDF)
Keynote document

Keynote document

TIFF image

TIFF image

TIFF image

TIFF image

10f 12 selected, 43.91 GB avalable

Click the Quick Look
button in the Finder
window toolbar.

Click here for a
— full-screen preview.

21
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When you view the documents in Quick Look, you can flip through each page of your
document or view each slide of a Keynote presentation.

Italian Architecture

COLOSSEUM
ELEVATION DETAIL

MAENIANUM

Each slide of a Keynote
presentation appears here.



You can use Quick Look to view several items at once. To automatically scan through the
items, click the Play button.

Click a picture in the
index sheet to view it.

Surf Instructor.tif

«p > |E" @

Click the Index Sheet Click the Camera button
button to view all the items. to add a photo to iPhoto.
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Time Mac

Ine

16416 sowosed, 9.9 G2 smadeble

Yesterday at 3:07 PM




To start using Time Machine, just connect a FireWire or USB disk to your computer, and
then click “Use as Backup Disk” in the dialog that appears.

When you turn on Time
Machine, it backs up your
computer to the disk
you've selected.

25
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Easily find a missing document by seeing how your desktop looked in the past. Time
Machine does a backup each hour of the current day, and then saves daily backups.

Type in the search
field to look for
the document.

Click the back
arrow to go back

‘ in time.
Use Quick Look to Browse items in When you find the
check a document your backup using document, select it and
before you restore it. Cover Flow. then click Restore.



To set Time Machine options, open Time Machine preferences. You can select a different
backup disk or specify folders or disks you don’t want to include in your backups.

ann Time Machine

Name: Backup
- Available: 182.2 GB of 232.9 GB

Oldest Backup: 6/16/07 4:57 PM

_Change Disk... | | . iast Backup: 8/27/07 3:08 PM

Options... | Next Backup: 8/27/07 4:13 PM

Click Options to select items

Time Machine e v o you don’t want to back up.

+ Hourly backups for the past 24 hours
+ Daily backups for the past month

OFF !—] ON » Weekly backups until your backup disk is full

n
[i Click the lock to prevent further changes. @
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Spaces

COLOSSEUM
ELEVATION DETAIL




Arrange windows
Turn on spaces in Exposé & Spaces preferences, and then press F8 to show your spaces. To
organize your windows, drag them from the current space to a different space.

The Westville Wiidcats

Drag windows you want
to use together into the
same space.

Spaces 29
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To switch between spaces, type Control + [an arrow key]. To go directly to a space, type
Control + [a number key]. Arrange the order of spaces to suit your needs.

Drag spaces to
rearrange their
order.

— Use keyboard shortcuts
to quickly switch
between spaces.



After you turn on spaces, you can add other spaces. You can also assign applications to
each space so that the application’s windows always open in the same space.

[ Xale) Exposé & Spaces

I

! Exposé | Spaces

Spaces lets you organize your windows into groups to reduce desktop clutter.
lz‘ Enable Spaces

"1 Show Spaces in menu bar

Rows: @ © Add rows and columns
catmei @ O to create the spaces
you need.
® Address Book Space 3
i ical Space 4 :
€) iChat Every Space N ‘
| I3 iTunes Space 2 i1

B Photo Booth

|-

Space 1 Abd
Keyboard and Mouse Shortcuts (for more shortcut choices, press Shift, Control, Option, or Command)
To activate Spaces: | F8 W (- =)
To switch between spaces: ['~ Arrow Keys L C] ChOOSG keyboa rd
To switch directly to a space: [~ Number K-evs s
ammm= shortcuts that work
® best for you.

Click the Add (+)
button to assign
applications to spaces.
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Mail

Use Apple-designed stationery to send gorgeous email

messages complete with photos.

[Z+] subject: Happy Birthday!

Favorites

Happy Birthday, Jessica!

Duis nonsequ ismodol oretuer dolore faidunt, luptat aolore con
secte dolesed st dolor sevelit er adionse agnisc aut landi gia
niet, vendre feum veniame onlutpatin hentip wisi ese dolesting
lorero consecte dunt utpatin elipit nim, quation ullu prat.

Best Wishes,
Tracey

Mail

i

1
L0
Thank You!

Eliquatuero dip eros nusan vent
t etlam, conum zritla
initit doloreet ullametuero od lor adit. o




Stationery

When you create a message, select stationery to give it the perfect style whether the

occasion is fun or formal. Including photos is easy using the Photo Browser.

Ge:
El Subject:
Favorites !—' b i
Birthday g; w
Announcements B
Photos - —
Stationery - | ‘ ;u!
Sentiments Air Mail Bamboo Tack Board Doodles

Fun in the sun.

Click to see the
stationery you can use.

— Select a type of stationery,

and then click the
stationery you want to use.

S

2 iPhoto
|28 Events
& Photos

|l Summer Trip
=1 Last 12 Months
¥ Last Import
™ Flagged

1 Photo Booth

— Select photos from
iPhoto, Photo Booth,
or Aperture.

Duis non sequ ismodol oreetuer irilet dolore facidunt, vulluptat se volore ct
dolesed dolor se velit et ver adion se magnisc illandi eti gniaet, vendre feun
acniamc onullutpatin hent ipiteti wisi esse dolesting ero dunt utpatin aut ipi
quation ullum ea autpatie eui nulla facilit la consectet odipsum magnis hen:
augiatie doluptat. Ut landiat te dolobortis nulput autpat luptate ndigniat vel

niam dolorti inullaore.

— Locate photos here,
and then drag them to
your message.

18 items
4

Mail

33
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Keep all your notes and to-do items in one place. Jot down reminders, shopping lists, and
information you need. Include pictures, URLs, and attachments with your items.

ene Notes (9 notes)

MAILBOXES | Subject
|7 Inbox [ 7] projes
-, Drafts @ T Workitoms
~/ Sent T Shopping
¥ Trash : Dinner plans

: ™ Reading quotes

[ Present ideas

¥ REMINDERS

./ ToDo 110
V¥ RSS
[ Apple Hot News | €10

New project

set up meeting with Juan
need guest list

where should we have it?

need a caterer

May 12, 2008
May 11, 2008

May 4, 2008

922MM

) call Bill for caterer’s name

need this info to pick a date for the event
will it be formal or casval?

Ted says the art gallery is a nice place for parties
(1 5/13/03 stop by gallery to diseuss

To Do Options

Wl # Due Date 571372008
O Alarm
M priority Medium$

Calendar Il calendar $

See your notes and to-do
items in the Reminders
section of the sidebar.

Click to create a
note or to-do item.

To create a to-do item,
select text in the note
and click To Do.

Click to set options for
the to-do item. Items
automatically appear in iCal.



Data detection

You can turn dates in your email messages into iCal events. You can add names, phone
numbers, and addresses to your contacts. You can even map addresses in Safari.

Join the Party — nbox

Help Us Celebrate!
Mary's Birthday
Sunday, May 11, 2008, 2:00 PM

i Children's Playground
1234 Main Street

Anytown, CA 9501
yiown, Cogort BT ¢/ oate New Contacts

Add to Existing Contact...
RSVP

telarkz@mac.com
(555) 555-5555

Show Map
Large Type

}
N4 e T T T T T T

Move the pointer over the
date, name, or address, and
then click the triangle to
choose an action.

Mail

35



iChat

Make your chats more fun using video effects such as
backdrops. Show off your work with iChat theater.

36 Chat



Use video backdrops with your chats to “be” anywhere in the world. iChat includes movies
and still photos that you can use, or you can add your own.

Select a video backdrop
and then step out of the
picture for a moment.

Video Effects

Click Effects to select
a video effect.

Add your own movies
or pictures to use as a
video backdrop.

37
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While you're in a video chat, you can select video effects to make your chats fun and

interesting.

Click the effect in the center
for the original view.

Video Effects

Black and White

2

Original “Color Pencil

Pop Art

Click any effect to
use it.



To show photos, movies, or presentations in a video chat, start the chat and then drag the
file or files you want to show to the chat window.

Video Chat with Ted Clark

Whitewater Rafting Trip

Guest List

$28500  $95.00
$10000  $280.00
$320.00
280,00

Chen WilamGmalbon us

Sophis245@pontive ret

1035 Green Mark@thenewlatior.com

Gichsond 1700maitorus
Marshal Oriando@postive.net

$10000
(530) 5557030

$15000  $200.00
$10000 84

(541) 5558142
(530) 8554508
(7075551673
541) 5552267

Méched_JenyOtrentarigaliery.com

Nancy, D_Nguyend@sbbanking com

See how your
presentation looks
to your buddy.

Parker_Seth@maibox s

ParkerE3798postive.com $285.00

7075551149
S30) 5557634

Fobens_ Greg@thanewletier com
Iiateta@compmadon com

$150.00
$1,170.00 $2.250.00

Budget

26500 $9500
$10000 528000

52000
$10000 828000

g
&

$15000 $20.00
om  $10000 820000

38000
28500 9500

|| Effects P Y
2 sy Parkr
$15000 323900

ez “
Total Guests 9 $1,170.00 52.250.00)

Control your —
presentation using
this window.

39
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Screen sharing lets you take control of a buddy’s computer to show how to do something,
rather than just explain it.

Findar _Fis £l Vwn Co Window Hals A Tho 504N G

Click to switch
screens. To copy a
document to this
computer, drag

it here.

.....
~~~~~
¥ Buddies

@ Marta Ruiz

© Mei Chen

O Gita's SMS
© Bill James

@ Ted Clark

@® Juan Chavez

:..! = m@s vorﬂine

Select a buddy with
video chat capability,
and then click the Screen
Sharing button.

[A[S[8]) A




Tabbed chats

Use tabbed chats if you have a lot of chats. To do so, open the Messages pane of iChat
preferences, and then select “Collect chats into a single window.”

Click a chat to

\/™' Mei Chen 5
.»' g/ What? )
. Juan Chavez
m Gita
Ravi Patel
Who?

See the latest reply
from your buddy.

iChat 41
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Presence
If you have more than one .Mac, AIM, Jabber, or Google Talk account, you can log into all
of them at the same time in iChat.

Use an animated GIF as
your buddy picture.

¥ Buddies

® Marta Ruiz

© Mei Chen

M Gita’s SMS =

@ Bill James

¥ v O Available
@ Ted Clark o O Surfing the web

@ Reading email
LS ® O At home
¥ Offiine a A Custom Available...
Ravi:Fatel @ Current iTunes Song
e
- @ Away L
¥ @ outtolunch I

@ On the phone
@ In a meeting
@ Custom Away...

BT Choose Invisible if you want
St to see who's available, but
Edit Status Menu... not be seen yOUI’SE'f.

iChat



SMS messaging
Exchange SMS messages from iChat with a buddy using a mobile phone, such as iPhone.
Choose File > Send SMS, and then enter your buddy’s phone number.

¥ Buddies

® Marta Ruiz i

® Mei Chen B m

© Gita's SMS | m . .
Bill James l This buddy can receive

g i SMS messages.

® Ted Clark (md 1

@ Juan Chavez ”b .

¥ Offline

Note: SMS messaging is available only with U.S. mobile phones.

(Chat 43
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Dashboard

August 2007
M LW T F

1| 2|3 4
o 5 6 7 8 9101
12 13 14 15 16 17 18

19 20 21 22 23 24 25
26 27 28 29 30 31

Thursday

Lake Trout Sauté

Flour, salt, and pepper
oasted bread crumbs

Rinse filets and pat dry
Dip each

Convert

| cup

\_ Tablespoon

;}56

CUPERTINO

= 896

League Matches

» Sat., June 3: Shooting Stars
« Sat., June 10: Blue Crushers
« Sun., June 11: Wolverines

« Sat., June 17: Fire Dragons
« Sun., June 18: Red Devils

« Sat., July 3: Sun Lizards

« Sat., July 10: Semi-finals

= Sun., July 11: Semi-finals

« Sat., July 17: Finals

Watch this space; schedules can
change!



To create a widget, open a webpage in Safari and choose File >“Open in Dashboard.”
Safari automatically selects parts of the page as you move the pointer over the page.

Go to the webpage in Safari
and click this button.

The Westville Wildcats

Ju € http://web.mac.com/annejohnsonl

Select part of the webpage, and then click Add.

League Matches

« Sat., June 3: Shooting Stars
« Sat., June 10: Blue Crushers
« Sun., June 11: Wolverines

« Sat., June 17: Fire Dragons
« Sun., June 18: Red Devils

« Sat., July 3: Sun Lizards

« Sat., July 10: Semi-finals

« Sun., July 11: Semi-finals

« Sat., July 17: Finals

Watch this space; schedules can

When you've
selected the part
you want, click Add.

Drag the selection
rectangle over the
information and click.
You can then resize the
selection.
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Safari

Eliquatuero dip eros numsan vent lam, conum

Read ab tet lor adit, commod tatummy niam Golorti
ead about  onutsore doior in estrud dunt lure te feugiam

modit dokorer iufe do con ulta dolor & meonse

our tnp and  ming exent am, quat velenit exuti erciut tate

duipsusci et landrem zzriusc inim nul taorem
ad\/entures! dipit nosenu nonautpat, Ut landiat utete

doiobor tis et nuliput luptate tat vendraet
lortiset dunt feugiam modit dolorer etuin
lutatum mconse.

Soccer Canic

et ismodot orestuer irll dojore
facidunt, vuliuptat volore consecte dolesed
utou dolor se velltdip numsan vent, conum
tetut for adit, commod tatumemy niam dolorti
onuliaore dolor In et estrud dunt iure te
feugiam modit dolorer lure o conulla &
MCoNse ming exentam poune:. qQuat velenit
exerciut tate duipsuscl et landrem 2znusc inim
nul laorem velenisit iure.

Duis nonseqt

Famiy Picnic
May 31

Duts nonsequ et ismodol orestuer irlf dofore
facigunt, vulluptat volore consecte dolesed
utou doloe se velitdip numsan vent, conum
tetut lor adit, commod tatumey niam dolorti
onuliaore dolor in et estrud dunt lure te
feugiam modit dolorer lure 6o conulla et
moonse ming axentam pound quat velen




Now you can drag tabs to arrange them or pull them out into a new window. To merge
open windows into a single tabbed window, choose Window > Merge All Windows.

| ) ttp:/ /web.mac.com/;

Home Slideshow Albums

N Subscribe

It's chilly up here in September! Kenji gets a bird's eye view

Get that fish awav from me!

Toni and Anna in the boat The latest in rowboat chic

Drag a tab out of the
window to putitina
separate window.

G— Drag tabs to rearrange

the order they're in.

To switch between tabs, press
Command-Shift-Right bracket
(1) or Command-Shift-Left
bracket ([).
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To search for text in a webpage, choose Edit > Find > Find, and then type your search.To
make it easier to see what you're looking for, Safari highlights all the results.

The Westville Wildcats

| 2 l@h!lp:,‘/web4mac.com/annejohnson/soccer

2 matches (<« » ) {Q semi-finals ( Done )
S 20k
TronTs o |

Click these arrows to

The Westville Wildcats E highlight individual

occurrences.

Safari highlights the results
in the webpage so that
they're easy to locate.

Photo Albums

Soccer Glinic
May 12-15

Our Soccer Season So Far

After being vanquished 3-0 by the Shooting Stars on June
3rd, the Wildcats came roaring back a week later to win 5-1
over the Blue Crushers.

Without starting goalie Mari, who was sick with a cold, the
'Cats needed to control the ball as much as possible. They
scored in the first three minutes. The tide turned quickly

Booster Club
May 22

when the Crushers capitalized off a corner kick. But the




PDF viewing

You can view PDF files in the Safari window. You'll find new controls that make it easier to
work with these files.

- Q- Google

FRESH & GREEN

The freshest local produce

IN-STORE CooKinGg ScHOOL
12:00 To 1:00 PM

Monday “
Spice up your

tofu!

W'l stir-fry tofu with spicy sauce,
vegetables, and peanuts to demonstrate
the versatility of this vegetarian staple.

Tuesday

s ameEn

E

We'll use local organic apples and
cranberries and all-natural ingredients to
make out-of-this-worid pies that tast
great without the guit.

the healthiest foods easy. Free in-store cooking Wednesday

Fresh & Green organic market makes finding

classes make eating healthy food fun!
8 Y ~ Wild side of asparagus
Asparagus, wid mushraoms
and pilaf are tha perfect
combo. See how well tneir
i each other

AUGUST NEWSLETTER

and how simpie it is to make
this dinner masterpiece.

hursday

€ Fresh & Green organic
market we see healthy cating
asa lifestyle. We suppart lacal
independent farms. We promote
healthy cooking education with our iand
free in-store cooking classes. We hice ta from scratch is much

Open the PDF file in
— B . o
g s A Mot I Preview or save it in
with our customers. 7 : tomato basil sauce.
your Downloads stack.

« Smart Dogs, 12 02.: 2 for $4.29
+ Lemon Herh Veggie Chicken: $3.69

« Fitm Tofu, 12.3 0z: $1.39

+ Organic Ranch Dressing: $3.89

N
August Specials

- an recipe cook-off
+ Organic Apples: $1.69/1b i ol best vegstarian dishes to

To see the controls, move
the pointer to the bottom
of the Safari window.
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Parental Controls
Give yourself peace of mind. Manage the time your children
spend on the computer and what they do there.

[

50 Parental Controls

';il Click the lock to prevent further changes.

Weekday time limits

wma Allows access to this computer Monday through Fi
- .| specified number of hours anly. Sty I

M Limit c P use to:

--------------

Weekend time limits

< Allows access to this computer Saturday and Sunday for the
" specified number of hours only.

™ Limit computer use to:

nnnnnnnnnnnnnn

/\ Bedtime
@ Prevents access to this computer during the specified hours.

# school nights:  9:00 PM (2] o 9:00am [3]
Sunday - Thursday

M Weekend: Iiboﬁ@ to 11:00 AM @

Friday and Saturday

@

Is, select a user

To turn on

™ Manage parental controls from another computer

To access this computer to change parental control
settings, you need the name and password of an
administrator of this computer.




Manage when your children use the computer by setting time limits for weekdays,

weekends, and nights.

QV 0.0 Parental Controls

pis

= rSyslem Content  Mail & iChat ' Time Limits = Logs

®d Marta Weekday time limits
Allows access to this computer Monday through Friday for the
4= Susan " specified number of hours only.
3 hours a day

M Limit ¢ use to: ©

30 minutes

4 Weekend time limits
Allows access to this computer Saturday and Sunday for the
specified number of hours only.
5 hours a day

B Lt computer use to: S=mm————ggem——

10 minute 8 h
Bedtime
Prevents access to this computer during the specified hours.
# School nights:  9:00 PM (2] to 9:00 AM [3]

o o
Sunday - Thursday
™ Weekend: 11:00 PM (2 to 11:00 AM [3]
Friday and Saturday
. riday ar ur
ol a
U] Click the lock to prevent further changes. @

— Specify how many
hours a day your child
may use the computer.

— Specify the hours during
which your child may not
use the computer on school

nights and weekends.
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To limit the websites your children may visit on the Internet, click Content and then select
the level of restrictions you want to apply.

Parental Controls

{ System ' Content = Mail & iChat  Time Limits

Logs

"1 Hide profanity in Dictionary

Limits access to certain words in
the Mac OS X dictionary.

Website Restrictions

Restricts website access to sites with
appropriate content or to a list of websites.

@ s

(O Allow unrestricted access to websites
(O Try to limit access to adult websi ically

Select to try limiting access
to adult websites. Click
Customize if you want to
specify websites your children

Customize

@ Allow access to only these websites

4 Discovery Kids

4 PBS Kids

4 HowstuffWorks

#4 National Geographic - Kids
% Yahoo! Kids

4 Disney

€4 Scholastic.com

€4 Smithsonian Institution

€4 Time for Kids

+ |-
N L

n
U] Click the lock to prevent further changes.

may and may not visit.

— Select to allow your
children access only to
specific websites.




Mail and iChat limits

Protect your children from strangers by specifying who they chat with and exchange

email with.

“vr

n
d Click the lock to preventf

I System  Content ' Mail &iChat = Time Limits

Logs —

™ Limit iChat

M Limit Mail
3 This user can exchange email and chat
A\ o with only the addresses added to the list.

Only allow emailing and instant messaging with:

gkumar@mac.com
ravipatel@mac.com fomel
jchavez4@mac.com
annejohnsonl@mac.com

|| Ravi Patel
|| Juan Chavez
|| Anne Johnson

Name | Email & Instant Messaging Address |
u’ Billjames bil’lja’mie'srz@;)'nrac.(om' ome)

|| Mei Chen meichen3@mac.com 1o

|| Gita Kumar

["1Send permission requests to:

email with a contact that is not in the list.

further changes.

Sends an email notifying the recipient that this user is attempting to exchange

@

Click the Add (+) button to
add an address.

isn't on the list.

—— Enter your email address to be
notified if your children try to
correspond with someone who
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Logs

Use the Logs pane to check your children’s activity on the computer and the Internet.

! System  Content  Mail & iChat  Time Limits t-hgv{—
Colby

—_— Group by
Log Collections | Logs
2 » % Amazon (1 time) . . .
B e e ume —— Find out which websites
I B > Go (11 times) . o .
@ Webshes Blockedd I} | @ 1o (3 imes) your children have visited.
o » 6% Google (6 times)
A Applications > @ Nick (19 times)
) > 64 Wikipedia (4 times)
Q'Chat » #9% Discovery (22 times)

>

> €% Yahoo (11 times)

Restrict ) ( Open

| %

m Click the lock to prevent further changes. @
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Remote controls

Manage parental controls on your child’s computer from your computer. When you turn
on parental controls, select “Manage parental controls from another computer.”

Other Computers

L Kid’s Mac

p— System

Content  Mail & iChat

Time Limits v-hsgr-}—

Show activity for: ' One week B

Colby

£ 2

m Click the lock to prevent furthe

Log Collections -

@ Websites Visited

@ Websites Blocked

Group by: [Website_‘!
| lLogs

» % Amazon (1 time)

» € Apple (1 time)

> Go (11 times)

» € Mac (3 times)

Select your child’s computer
and log in; then select your
child’s user name.

~
e Colby
»d Marta
4= Susan
To turn on parental controls, select a user account.
E Manage parental controls from another computer
To access this computer to change parental control
settings, you need the name and password of an
administrator of this computer.
Foe

n
d Click the lock to prevent further changes.

— Select this option on
your child’s computer.
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Photo Booth

(&N
Photo Booth

=1 32 photos and 1 movie — — e =




“Be” anywhere in the world—or out of this world—by using video backdrops when you

take a snapshot.

800 Photo Booth

Select a backdrop, and then
step out of the picture for a
moment.

Color Dots Earthrism
d

Normal

19 photos and 2 movies
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Now you can make a burst of four snapshots. You can export a 4-up snapshot as an
animated GIF to use as your buddy picture in iChat.

When previewing a
4-up snapshot, click
a frame to preview
that frame and select
how to use it.

Click the 4-up
button.




Movie clips
Make a movie of yourself using effects and backdrops. Use your movie as a video greeting
complete with audio to send to your friends in an email message.

When you preview
a movie, move the
pointer over the
image to control
playback.

Click the Movie
Clip button.

Photo Booth 59



60

Front Row

Photos

Shared Photos



To open Front Row, click Menu on your Apple Remote. Click Volume Up and Volume Down
to highlight items. Click Play to select an item. Click Menu to return to the previous menu.

Front Row

DVD

Movies Select what you
TV Shows want to watch.
Music

Podcasts

Photos

Settings

Sources

— Use your Apple
Remote to sit back
and enjoy the show.
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Turn your Mac into a gallery for your favorite photos. With Front Row, you can show your
photos in iPhoto, Photo Booth, and Aperture.

Click to view
@ Photos
shared photos on
Shared Photos — your network.
Photos — Choose the
T photo album or

‘ Last 12 Months

[V —

iPhoto Event you
want to show.




From Front Row, you can view digital entertainment shared from other computers on
your network.

Shared Photos

Slideshow Settings

— Select how you
want Front Row
Ted Clark’s Photos

to display your
Gita’s Photos play’y

photos.
Marta’s Photos

63



Boot Camp
To use a Windows application on your Mac, install Boot Camp
and your copy of Windows. Then you're ready to go.

64 Boot Camp



Install Boot Camp
Open Boot Camp Setup Assistant (in the Utilities folder in the Applications folder) and
print the Boot Camp Installation & Setup Guide. Then create a partition for Windows.

Introduction

The Boot Camp Assistant helps you install Microsoft Windows XP or ’
Windows Vista operating systems on an Intel-haced Mac comnuter

Print the Boot Camp Installation & Setup G
| Windows. You'll need this document to co

Create a Partition for Windows

IMPORTANT: Back up your disk before pa
Windows. If you are installing Windows on

connect the power adapter. Each operating system requires its own partition on the disk.

Drag the divider to set the size of the partitions, or click one
of the buttons.

=} "Macintosh HD" will be partitioned as:

0 @,
& »
Mac 0S X Windows
106 GB 5GB
87 GB free

( Divide Equally ) ( Use 32 GB )

( Print Installation & Setup Guide )

Print this document to
follow the instructions
while installing Windows.

( Go Back ( Partition )

Drag the divider to
set the size of the
Windows partition.

If you installed a beta version of Boot Camp, you only need to install the new Windows
drivers by switching to Windows and inserting the Leopard installation disc.

Boot Camp 65



Install Windows
Insert your Windows XP or Windows Vista installation disc and click Start Installation.

Start Windows Installation

Insert your Windows installation disc and click Start
Installation.

You'll need an authentic 32-bit Microsoft Windows XP Home
Edition or Professional with Service Pack 2 or later, or
Windows Vista Home Basic, Home Premium, Business, or

Ultimate disc.
After you have installed and set up Windows, insert your Mac InSta” the WindOWS driverS
0S X Leopard install disc to install additional drivers and . . .
other software for Windows. when you finish installing
and setting up Windows.
( Quit & Install Later ) (' Go Back \ ( Start Installation )

Click when you're ready
to install Windows on
your Mac.
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In Mac OS X, open Startup Disk preferences to select your Windows partition. In Windows,
open the Boot Camp Control Panel and then click Startup Disk.

() On Startup Disk

= I 2} Select your Windows
Mac OS X, 10.5 Windows Network Startup gt B
on Macintosh HD on Untitled partltlon and then C||Ck
Restart.
You have selected Mac OS X, 10.5
on the volume “Macintosh HD."
Click to restart this computer in Targ BootiCemp ContiplBancl @

After you restart this computer in Target Dij|
to another computer using a FireWire cable

Startup Disk ‘Briahtness | Remate | Keyboard Powen;i

Select the system you want to use to start up your computer

N
j lick the lock to prevent furthercif | | —— =
14" clck th fock o prevent fur @ @ ] | Select your Mac OS X
Macintosh HD ~ Windows sta rtup dISk and then
click Restart.

Click to restart this computer in Target Disk Mode.

After you restart this computer in Target Disk Mode, you can connect it Target Disk Mode...

to another computer using a FireWire cable and use it as a hard disk.
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Here if you need us

www.apple.com/support
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Online resources

For online service and support information, visit www.apple.com/support. Choose
your country from the pop-up menu. You can search for the latest software updates
and manuals, find answers using the AppleCare Knowledge Base, or get help from
Apple’s discussion forums.

Onscreen help

You can often find answers to your questions, as well as instructions and problem-
solving information by using the Help menu in some applications. Choose Help from
the Finder Help menu, type a few words in the search field, and then press Return.

System profiler

Use System Profiler to retrieve information about your computer. System Profiler
indicates the hardware and software installed on your computer, the serial number
and operating system version, the amount of memory installed, and how much
battery power remains. To open System Profiler, choose Apple (&) > About This Mac
from the menu bar, and then click the “More Info” button.



Your Mac OS X product comes with 90 days of complimentary telephone support.

AppleCare telephone support representatives can help you open and install
applications and solve basic problems. Consult the table below, and then call the
support center nearest you. Have the date of purchase and your Apple computer

serial number ready when you call.

Note: Telephone fees may apply.

You can extend your coverage by purchasing the AppleCare Protection Plan. For
more information about the AppleCare Protection Plan, visit the AppleCare Products
and Services website at www.apple.com/support/products.

For additional information about contacting Apple Support, visit www.apple.com/
contact/phone_contacts.html. (Telephone numbers are subject to change.)

Technical Support Numbers

United States 1-800-275 2273
Canada (English) 1-800-263-3394
Canada (French) 1-800-263-3394
Mexico 01-800-277-5322
Australia (61) 133-622

New Zealand 00800-7666-7666
United Kingdom (44) 0870 876 0753

www.apple.com/support
www.apple.com/ca/support
www.apple.com/ca/fr/support
www.apple.com/mx/support
www.apple.com/au/support
www.apple.com/nz/support

www.apple.com/uk/support
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APPLE INC.

Single Use and Family Pack License for use on Apple-labeled Systems

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT (“LICENSE”) CAREFULLY BEFORE USING THE APPLE
SOFTWARE. BY USING THE APPLE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS
LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, DO NOT USE THE SOFTWARE. IF YOU DO NOT
AGREE TO THE TERMS OF THE LICENSE, YOU MAY RETURN THE APPLE SOFTWARE TO THE PLACE WHERE YOU
OBTAINED IT FOR A REFUND. IF THE APPLE SOFTWARE WAS ACCESSED ELECTRONICALLY, CLICK“DISAGREE/
DECLINE” FOR APPLE SOFTWARE INCLUDED WITH YOUR PURCHASE OF HARDWARE, YOU MUST RETURN THE
ENTIRE HARDWARE/SOFTWARE PACKAGE IN ORDER TO OBTAIN A REFUND.

IMPORTANT NOTE: This software may be used to reproduce, modify, publish and distribute materials. It is
licensed to you only for reproduction, modification, publication and distribution of non-copyrighted materials,
materials in which you own the copyright, or materials you are authorized or legally permitted to reproduce,
modify, publish or distribute. If you are uncertain about your right to copy, modify, publish or distribute any
material, you should contact your legal advisor.

1. General. The software (including Boot ROM code), documentation and any fonts accompanying this License
whether preinstalled on Apple-labeled hardware, on disk, in read only memory, on any other media or in any
other form (collectively the “Apple Software”) are licensed, not sold, to you by Apple Inc. (“Apple”) for use only
under the terms of this License, and Apple reserves all rights not expressly granted to you. The rights granted
herein are limited to Apple’s and its licensors’ intellectual property rights in the Apple Software as licensed
hereunder and do not include any other patents or intellectual property rights. You own the media on which
the Apple Software is recorded but Apple and/or Apple’s licensor(s) retain ownership of the Apple Software
itself. The terms of this License will govern any software upgrades provided by Apple that replace and/or
supplement the original Apple Software product, unless such upgrade is accompanied by a separate license in
which case the terms of that license will govern.

Title and intellectual property rights in and to any content displayed by or accessed through the Apple
Software belongs to the respective content owner. Such content may be protected by copyright or other
intellectual property laws and treaties, and may be subject to terms of use of the third party providing such
content. This License does not grant you any rights to use such content nor does it guarantee that such content
will continue to be available to you.

2. Permitted License Uses and Restrictions.

A.Single Use. This License allows you to install, use and run one (1) copy of the Apple Software on a single
Apple-labeled computer at a time. You agree not to install, use or run the Apple Software on any non-Apple-



labeled computer, or to enable others to do so. This License does not allow the Apple Software to exist on more
than one computer at a time, and you may not make the Apple Software available over a network where it
could be used by multiple computers at the same time.

B. Family Pack. If you have purchased a Mac OS X Family Pack, this License allows you to install and use one

(1) copy of the Apple Software on up to a maximum of five (5) Apple-labeled computers at a time as long as
those computers are located in the same household and used by persons who occupy that same household.
By “household” we mean a person or persons who share the same housing unit such as a home, apartment,
mobile home or condominium, but shall also extend to student members who are primary residents of that
household but residing at a separate on-campus location. The Family Pack License does not extend to business
or commercial users.

C.You may make one copy of the Apple Software (excluding the Boot ROM code and other Apple firmware
that is embedded or otherwise contained in Apple-labeled hardware) in machine-readable form for backup
purposes only; provided that the backup copy must include all copyright or other proprietary notices contained
on the original. Apple Boot ROM code and firmware is provided only for use on Apple-labeled hardware and
you may not copy, modify or redistribute the Apple Boot ROM code or firmware, or any portions thereof.

D. Certain components of the Apple Software, and third party open source programs included with the

Apple Software, have been or may be made available by Apple on its Open Source web site (http://www.
opensource.apple.com/) (collectively the “Open-Sourced Components”). You may modify or replace only these
Open-Sourced Components; provided that: (i) the resultant modified Apple Software is used, in place of the
unmodified Apple Software, on a single Apple-labeled computer; and (ii) you otherwise comply with the terms
of this License and any applicable licensing terms governing use of the Open-Sourced Components. Apple is
not obligated to provide any updates, maintenance, warranty, technical or other support, or services for the
resultant modified Apple Software.

You expressly acknowledge that if failure or damage to Apple hardware results from modification of the Open-
Sourced Components of the Apple Software, such failure or damage is excluded from the terms of the Apple
hardware warranty.

E. Apple has provided, as part of the Apple Software package, access to certain third party software as a
convenience. To the extent that the Apple Software contains third party software, Apple has no express or
implied obligation to provide any technical or other support for such software. Please contact the appropriate
software vendor or manufacturer directly for technical support and customer service related to its software and
products.

F. Except as and only to the extent permitted by applicable licensing terms governing use of the Open-Sourced
Components, or by applicable law, you may not copy, decompile, reverse engineer, disassemble, modify, or
create derivative works of the Apple Software or any part thereof. THE APPLE SOFTWARE IS NOT INTENDED
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FOR USE IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS,
AIR TRAFFIC CONTROL SYSTEMS, LIFE SUPPORT MACHINES OR OTHER EQUIPMENT IN WHICH THE FAILURE OF
THE APPLE SOFTWARE COULD LEAD TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL
DAMAGE.

G. If you use Setup/Migration Assistant to transfer software from one Apple-labeled computer to another
Apple-labeled computer, please remember that continued use of the original copy of the software may be
prohibited once a copy has been transferred to another computer, unless you already have a licensed copy of
such software on both computers. You should check the relevant software license agreements for applicable
terms and conditions.

3.Transfer. You may not rent, lease, lend, redistribute or sublicense the Apple Software. Subject to the
restrictions set forth below, you may, however, make a one-time permanent transfer of all of your license
rights to the Apple Software (in its original form as provided by Apple) to another party, provided that: (a) the
transfer must include all of the Apple Software, including all its component parts (excluding Apple Boot ROM
code and firmware), original media, printed materials and this License; (b) you do not retain any copies of the
Apple Software, full or partial, including copies stored on a computer or other storage device; and (c) the party
receiving the Apple Software reads and agrees to accept the terms and conditions of this License. You may
not rent, lease, lend, redistribute, sublicense or transfer any Apple Software that has been modified or replaced
under Section 2D above. All components of the Apple Software are provided as part of a bundle and may not
be separated from the bundle and distributed as standalone applications. Apple Software provided with a
particular Apple-labeled hardware product may not run on other models of Apple-labeled hardware.

Updates: If an Apple Software update completely replaces (full install) a previously licensed version of the
Apple Software, you may not use both versions of the Apple Software at the same time nor may you transfer
them separately.

NFR (Not for Resale) and Evaluation Copies: Notwithstanding other sections of this License, Apple Software
labeled or otherwise provided to you on a promotional or not-for-resale basis may only be used for
demonstration, testing and evaluation purposes and may not be resold or transferred.

Apple System Restore Copies: Restore CDs or DVDs that may accompany an Apple hardware bundle, or are
otherwise provided by Apple in connection with an Apple hardware bundle, contain a copy of the Apple
Software that is to be used for diagnostic and restorative purposes only. These CDs and DVDs may be resold or
transferred only as part of the Apple hardware bundle.

Academic Copies: If the Apple Software package has an academic label or if you acquired the Apple Software
at an academic discount, you must be an Eligible Educational End User to use the Apple Software.“Eligible
Educational End Users” means students, faculty, staff and administration attending and/or working at an
educational institutional facility (i.e., college campus, public or private K-12 schools).



4. Consent to Use of Data. You agree that Apple and its subsidiaries may collect and use technical and related
information, including but not limited to technical information about your computer, system and application
software, and peripherals, that is gathered periodically to facilitate the provision of software updates, product
support and other services to you (if any) related to the Apple Software, and to verify compliance with the
terms of this License. Apple may use this information, as long as it is in a form that does not personally identify
you, to improve our products or to provide services or technologies to you.

5.Termination. This License is effective until terminated. Your rights under this License will terminate
automatically without notice from Apple if you fail to comply with any term(s) of this License. Upon the
termination of this License, you shall cease all use of the Apple Software and destroy all copies, full or partial, of
the Apple Software.

6. Limited Warranty on Media. Apple warrants the media on which the Apple Software is recorded and
delivered by Apple to be free from defects in materials and workmanship under normal use for a period of
ninety (90) days from the date of original retail purchase. Your exclusive remedy under this Section shall be, at
Apple’s option, a refund of the purchase price of the product containing the Apple Software or replacement

of the Apple Software which is returned to Apple or an Apple authorized representative with a copy of the
receipt. THIS LIMITED WARRANTY AND ANY IMPLIED WARRANTIES ON THE MEDIA INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, OF SATISFACTORY QUALITY, AND OF FITNESS FOR
A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF ORIGINAL RETAIL
PURCHASE. SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS,
SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU. THE LIMITED WARRANTY SET FORTH HEREIN IS THE ONLY
WARRANTY MADE TO YOU AND IS PROVIDED IN LIEU OF ANY OTHER WARRANTIES (IF ANY) CREATED BY ANY
DOCUMENTATION, PACKAGING OR OTHERWISE. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS,
AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY BY JURISDICTION.

7.Disclaimer of Warranties. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE APPLE SOFTWARE
IS AT YOUR SOLE RISK AND THAT THE ENTIRE RISK AS TO SATISFACTORY QUALITY, PERFORMANCE, ACCURACY
AND EFFORT IS WITH YOU. EXCEPT FOR THE LIMITED WARRANTY ON MEDIA SET FORTH ABOVE AND TO THE
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE APPLE SOFTWARE AND ANY SERVICES PERFORMED
OR PROVIDED BY THE APPLE SOFTWARE (“SERVICES”) ARE PROVIDED “AS IS7WITH ALL FAULTS AND WITHOUT
WARRANTY OF ANY KIND, AND APPLE AND APPLE'S LICENSORS (COLLECTIVELY REFERRED TO AS “APPLE” FOR
THE PURPOSES OF SECTIONS 7 and 8) HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS WITH RESPECT
TO THE APPLE SOFTWARE AND ANY SERVICES, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY, OF SATISFACTORY
QUALITY, OF FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY, OF QUIET ENJOYMENT, AND NON-
INFRINGEMENT OF THIRD PARTY RIGHTS. APPLE DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR
ENJOYMENT OF THE APPLE SOFTWARE, THAT THE FUNCTIONS CONTAINED IN, OR SERVICES PERFORMED
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OR PROVIDED BY, THE APPLE SOFTWARE WILL MEET YOUR REQUIREMENTS, THAT THE OPERATION OF THE
APPLE SOFTWARE OR SERVICES WILL BE UNINTERRUPTED OR ERROR-FREE, THAT THE APPLE SOFTWARE OR
SERVICES WILL BE COMPATIBLE WITH THIRD PARTY SOFTWARE, OR THAT DEFECTS IN THE APPLE SOFTWARE OR
SERVICES WILL BE CORRECTED. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY APPLE OR AN APPLE
AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY. SHOULD THE APPLE SOFTWARE OR SERVICES
PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON
APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO THE ABOVE EXCLUSION AND LIMITATIONS MAY NOT
APPLY TO YOU.

The Apple Software automatically references, displays, links to, and provides web services related to, sites

and information located worldwide throughout the Internet. Because Apple has no control over such sites
and information, Apple makes no guarantees as to such sites and information, including but not limited

to: (a) the accuracy, availability, sequence, completeness, currency, content, validity or quality of any such

sites and information, or (b) whether an Apple search completed through the Apple Software may locate
unintended or objectionable content. Because some of the content on the Internet consists of material that

is adult-oriented or otherwise objectionable to some people or viewers under the age of 18, the results of

any search or entering of a particular URL using the Apple Software may automatically and unintentionally
generate links or references to objectionable material. By using the Apple Software, you acknowledge that
Apple makes no representations or warranties with regard to any sites or information displayed by or accessed
through the Apple Software, or any web services performed by the Apple Software in relation to such sites

or information. Apple, its officers, affiliates and subsidiaries shall not, directly or indirectly, be liable, in any

way, to you or any other person for the content you receive using the Apple Software or for any inaccuracies,
errors in or omissions from the content. Financial information displayed by the Apple Software is for general
informational purposes only and is not intended to be relied upon as investment advice. Before executing any
securities transaction based upon information obtained through the Apple Software, you should consult with
a financial professional. Neither Apple nor any of its content providers guarantees the accuracy, completeness,
or timeliness of stock information appearing within the Apple Software. The Apple Software may be used

to conduct automated translations. As automated translations are performed by software tools and do not
involve any human intervention or verification, it is not advisable to rely upon such translations where absolute
accuracy is required. Backup functions performed by the Apple Software are only carried out at certain times
and are subject to hardware limitations such as drive storage capacity.

Apple and its licensors reserve the right to change, suspend, remove, or disable access to any Services at any
time without notice. In no event will Apple be liable for the removal of or disabling of access to any such
Services. Apple may also impose limits on the use of or access to certain Services, in any case and without
notice or liability.



8. Limitation of Liability. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT SHALL APPLE BE LIABLE FOR
PERSONAL INJURY, OR ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES WHATSOEVER,
INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, LOSS OF DATA, BUSINESS INTERRUPTION
OR ANY OTHER COMMERCIAL DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO YOUR USE OR INABILITY
TO USE THE APPLE SOFTWARE, HOWEVER CAUSED, REGARDLESS OF THE THEORY OF LIABILITY (CONTRACT,
TORT OR OTHERWISE) AND EVEN IF APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME
JURISDICTIONS DO NOT ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL INJURY, OR OF INCIDENTAL

OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY TO YOU. In no event shall Apple’s total
liability to you for all damages (other than as may be required by applicable law in cases involving personal
injury) exceed the amount of fifty dollars (§50.00). The foregoing limitations will apply even if the above stated
remedy fails of its essential purpose.

9. Digital Certificates.

General. The Apple Software contains functionality that allows it to accept digital certificates either issued

from Apple or from third parties. YOU ARE SOLELY RESPONSIBLE FOR DECIDING WHETHER OR NOT TO RELY

ON A CERTIFICATE WHETHER ISSUED BY APPLE OR A THIRD PARTY. YOUR USE OF DIGITAL CERTIFICATES IS

AT YOUR SOLE RISK. APPLE MAKES NO WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, AS TO
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE, ACCURACY, SECURITY, OR NON-INFRINGEMENT
OF THIRD PARTY RIGHTS WITH RESPECT TO DIGITAL CERTIFICATES. You agree that (a) you will not falsify or
misuse any certificate; (b) you will use Digital Certificates for legal purposes only and in accordance with any
applicable Certificate Policy, Certificate Practice Statement or other Certificate Authority business practice
disclosures; (c) you are solely responsible for preventing any unauthorized user from making use of your Digital
Certificates; and (d) you will revoke any certificate that you have reason to believe has been compromised.

Use of Digital Certificates in iChat. The Apple Software allows you to encrypt your iChat communications. This
feature uses digital certificates to verify that the iChat is coming from the iChat screen name that appears in
the iChat window and to encrypt and decrypt the chat. It does not verify the identity of the person using

that screen name. Apple does not guarantee that there will be no hacking or intrusions into the chat. YOUR
USE OF THIS FEATURE IN CONNECTION WITH ICHAT IS AT YOUR SOLE RISK. APPLE MAKES NO WARRANTIES OR
REPRESENTATIONS, EXPRESS OR IMPLIED, AS TO MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE,
ACCURACY, SECURITY, OR NON-INFRINGEMENT OF THIRD PARTY RIGHTS WITH RESPECT TO THE USE OF DIGITAL
CERTIFICATES AND/OR ENCRYPTION IN ICHAT. By using the Apple Software, you agree that (a) you will take no
action that interferes with the normal operation of digital certificates or encryption used in an iChat session

or otherwise falsify the digital certificate used to validate a screen name; (b) you will use the encrypted iChat
function solely for legal purposes; (c) you are solely responsible for preventing any unauthorized user from
having access to any certificate or private key stored on your computer; and (d) you will revoke any certificate
that you have reason to believe is compromised. Apple’s Certificate Policy and Certificate Practice Statements
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may be found at: http://www.apple.com/certificateauthority.

10. Export Control. You may not use or otherwise export or reexport the Apple Product except as authorized
by United States law and the laws of the jurisdiction in which the Apple Product was obtained. In particular,
but without limitation, the Apple Product may not be exported or re-exported (a) into any U.S. embargoed
countries or (b) to anyone on the U.S. Treasury Department’s list of Specially Designated Nationals or the U.S.
Department of Commerce Denied Person’s List or Entity List. By using the Apple Product, you represent and
warrant that you are not located in any such country or on any such list.

11. Government End Users. The Apple Software and related documentation are “Commercial Items’ as that
term is defined at 48 C.F.R. §2.101, consisting of “Commercial Computer Software” and “Commercial Computer
Software Documentation’ as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. §227.7202, as applicable.
Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §227.7202-1 through 227.7202-4, as applicable, the Commercial
Computer Software and Commercial Computer Software Documentation are being licensed to U.S.
Government end users (a) only as Commercial Items and (b) with only those rights as are granted to all other
end users pursuant to the terms and conditions herein. Unpublished-rights reserved under the copyright laws
of the United States.

12. Controlling Law and Severability. This License will be governed by and construed in accordance with the
laws of the State of California, as applied to agreements entered into and to be performed entirely within
California between California residents. This License shall not be governed by the United Nations Convention
on Contracts for the International Sale of Goods, the application of which is expressly excluded. If for any reason
a court of competent jurisdiction finds any provision, or portion thereof, to be unenforceable, the remainder of
this License shall continue in full force and effect.

13. Complete Agreement; Governing Language. This License constitutes the entire agreement between

the parties with respect to the use of the Apple Software licensed hereunder and supersedes all prior or
contemporaneous understandings regarding such subject matter. No amendment to or modification of this
License will be binding unless in writing and signed by Apple. Any translation of this License is done for local
requirements and in the event of a dispute between the English and any non-English versions, the English
version of this License shall govern.

14.Third Party Acknowledgements.

A. Portions of the Apple Software utilize or include third party software and other copyrighted material.
Acknowledgements, licensing terms and disclaimers for such material are contained in the “online” electronic
documentation for the Apple Software, and your use of such material is governed by their respective terms.

B. Certain software libraries and other third party software included with the Apple Software are free software
and licensed under the terms of the GNU General Public License (GPL) or the GNU Library/Lesser General Public
License (LGPL), as the case may be. You may obtain a complete machine-readable copy of the source code



for such free software under the terms of the GPL or LGPL, as the case may be, without charge except for the
cost of media, shipping, and handling, upon written request to Apple. The GPL/LGPL software is distributed

in the hope that it will be useful, but WITHOUT ANY WARRANTY, without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of the GPL and LGPL is included with the
Apple Software.

C.The Apple Software includes certain software licensed under the IBM Public License Version 1.0 (IPL) or the
Common Public License Version 1.0 (CPL). A copy of the source code for the IPL and CPL licensed software may
be found in Apple’s Open Source repository. See Apple’s Open Source web site (http://www.opensource.apple.
com/) for information on how to obtain the source code. THE IPL AND CPL SOFTWARE IS PROVIDED ON AN

“AS 1S” BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, EITHER EXPRESS OR IMPLIED INCLUDING,
WITHOUT LIMITATION, ANY WARRANTIES OR CONDITIONS OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE. NEITHER APPLE, IBM NOR ANY OTHER CONTRIBUTOR TO THE IPL
AND CPL SOFTWARE SHALL HAVE ANY LIABILITY FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
OR CONSEQUENTIAL DAMAGES (INCLUDING, WITHOUT LIMITATION, LOST PROFITS), HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OR DISTRIBUTION OF THE IPL AND CPL SOFTWARE OR THE
EXERCISE OF ANY RIGHTS GRANTED HEREUNDER, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

D. MPEG-2 Notice. To the extent that the Apple Software contains MPEG-2 functionality, the following provision
applies: ANY USE OF THIS PRODUCT OTHER THAN CONSUMER PERSONAL USE IN ANY MANNER THAT COMPLIES
WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR PACKAGED MEDIA IS EXPRESSLY
PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH
LICENSE IS AVAILABLE FROM MPEG LA, L.L.C, 250 STEELE STREET, SUITE 300, DENVER, COLORADO 80206.

E. Use of MPEG-4. This product is licensed under the MPEG-4 Systems Patent Portfolio License for encoding in
compliance with the MPEG-4 Systems Standard, except that an additional license and payment of royalties are
necessary for encoding in connection with (i) data stored or replicated in physical media which is paid for on a
title by title basis and/or (ii) data which is paid for on a title by title basis and is transmitted to an end user for
permanent storage and/or use. Such additional license may be obtained from MPEG LA, LLC. See http://www.
mpegla.com for additional details.

This product is licensed under the MPEG-4 Visual Patent Portfolio License for the personal and non-commercial
use of a consumer for (i) encoding video in compliance with the MPEG-4 Visual Standard (“MPEG-4 Video”) and/
or (ii) decoding MPEG-4 video that was encoded by a consumer engaged in a personal and non-commercial
activity and/or was obtained from a video provider licensed by MPEG LA to provide MPEG-4 video. No license is
granted or shall be implied for any other use.

Additional information including that relating to promotional, internal and commercial uses and licensing
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may be obtained from MPEG LA, LLC. See http: //www.mpegla.com. For answers to frequently asked questions
regarding use fees under the MPEG LA Visual Patent Portfolio License see www.apple.com/mpeg4 or www.
apple.com/quicktime/products/qt/fag.html.

F.H.264/AVC Notice. To the extent that the Apple Software contains AVC encoding and/or decoding
functionality, commercial use of H.264/AVC requires additional licensing and the following provision applies:
THE AVC FUNCTIONALITY IN THIS PRODUCT IS LICENSED HEREIN ONLY FOR THE PERSONAL AND NON-
COMMERCIAL USE OF A CONSUMER TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC
VIDEO") AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND
NON-COMMERCIAL ACTIVITY AND/OR AVC VIDEO THAT WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO
PROVIDE AVC VIDEO. INFORMATION REGARDING OTHER USES AND LICENSES MAY BE OBTAINED FROM MPEG
LA L.L.C. SEE HTTP://WWW.MPEGLA.COM.

G. AMR Notice. The Adaptive Multi-Rate (“AMR”) encoding and decoding functionality in this product is not
licensed to perform cellular voice calls, or for use in any telephony products built on the QuickTime architecture
for the Windows platform. The AMR encoding and decoding functionality in this product is also not licensed for
use in a cellular communications infrastructure including: base stations, base station controllers/radio network
controllers, switching centers, and gateways to and from the public switched network.

H. FAA Notice. Aircraft Situation Display and National Airspace System Status Information data (collectively
“Flight Data”) displayed through the Apple Software is generated by the Federal Aviation Administration. You
agree not to redistribute Flight Data without the prior written consent of the FAA. The FAA and Apple disclaim
all warranties, expressed or implied (including the implied warranties of merchantability and fitness for a
particular purpose), regarding the use and accuracy of the Flight Data. You agree that the FAA and Apple shall
not be liable, either collectively or individually, for any loss, damage, claim, liability, expense, or penalty, or for
any indirect, special, secondary, incidental, or consequential damages deriving from the use of the Flight Data.
The Apple Software is not sponsored or endorsed by the FAA. The FAA is not responsible for technical or system
problems, and you should not contact the FAA regarding such problems or regarding operational traffic flow
issues.

I. Use of Adobe Color Profiles. You may use the Adobe Color Profile software included with the Apple Software
pursuant to this License, but Adobe is under no obligation to provide any support for the Color Profiles
hereunder, including upgrades or future versions of the Profiles or other items. In addition to the provisions of
Sections 7 and 8 above, IN NO EVENT WILL ADOBE BE LIABLE TO YOU FOR ANY DAMAGES, CLAIMS OR COSTS
WHATSOEVER. The Adobe Color Profile software distributed with the Apple Software is also available for
download from Adobe at www.adobe.com.
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